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USA Staffing

USA Staffing Reporting & Analytics
Reporting and Analytics Workgroup Meeting
February 1, 2022

We will start at approx. 1:03 EDT to allow time for people to sign in

Created by the OPM Federal Staffing Center

OFFICIAL USE NOTICE: This material is intended exclusively for use by USA Staffing Customers and is not to be
distributed without approval from the USA Staffing Program Office. This communication may contain information that
is proprietary, privileged, confidential or otherwise legally exempt from disclosure. If you have received this presentation
in error, please notify the USA Staffing Program Office immediately and delete all copies of the material.
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Agenda

- Program Updates
* Power Bl Update
« Cognos Performance
« Cognos Training Program

« Retiring Data Packages
New Hire (End of Day)
Staffing Analytics

* Modifications to Reports and Data Models

* Reports
« Data Models

- Cognos Tip

o Applicant Flow Data Reporting
- APl Updates
 Open Demo and Q&A
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Power Bl Implementation Milestones

Minimum Viable Product (MVP) 1: A data set and dashboard published in a shared
workspace available to customers.

User Research User Testing A“c’;:":::!eto
\ Dashboard and

Dashboard Design

MVP Data Set Published

for Customers

Dashboard Design
Prototype & Data
Model MVP
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Power Bl Implementation Milestones

Report Design and Data Prep 9

» User authentication
« Dataset development and performance testing
* Move data and sources to the cloud
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Cognos Performance

Starting on Friday, January 7, 2022, we experienced a number of issues that resulted in

unscheduled Cognos downtime and availability issues.

January 7, 2022 (downtime):

» All Cognos servers unable to connect
» Upgrade to Cognos 11.1 (originally scheduled for 1/10/22)
January 8 - 9, 2022 (online - reduced capacity):
« Some Cognos servers unable to connect
January 10, 2022 (downtime):

« Some Cognos servers unable to connect

January 11 - AM 13, 2022 (online):

« All Cognos servers able to connect

« Performance issues and errors when attempting to
access, edit, and run reports in Cognos 11.1

« Servers upgraded to try to resolve issues and errors
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Cognos Performance

January 13 (PM), 2022 (downtime):
« Cognos rolled back to 11.0

January 14 - 20, 2022 (online):

« Some users indicate intermittent issues running, editing,
and creating reports

* Blank white screen; and/or

 "404 — Not Found” errors

'

January 21, 2022 to present (online - availability issues):

(

» Users experience SSO errors when attempting to log
in to Cognos

 Instructions for clearing VPN cache sent out
January 22, 2022 to present (online):

* Normal operations
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Cognos Training Program
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Cognos Training Program

Report Consumer Report Author Advanced Author
Training Training Forum
Who? * New USA Staffing *New report authors * Experienced report
reports users authors
What?  <How to navigate to *How to get started *Open forum for
and run reports building reports authors to ask
questions
Time? <2 day 142 days 1 hour
When? One session per month, alternating between * The first Thursday of
each Report Consumer Training and Report each month at 11:00
Author Training AM EDT
How? Contact your USA Staffing Account Manager to * All report authors are
sign-up. welcome. Questions
can be submitted in
advance

Meeting information for the forum will be sent to current report authors in the Production environment.
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Cognos Training Dates

Report Consumer Report Author

Training Training

Advanced Author
Forum

Dates Wednesday, March 30 Tuesday, February 22

1:00 — 4:00 PM EDT 10:00 AM - 3:00 PM EDT
+

Wednesday, February 23
10:00 AM - 3:00 PM EDT

How to Contact your USA Staffing Account Manager.
Register

Thursday, February 3
11:00 AM - 12:00 PM EDT

Thursday, March 3
11:00 AM - 12:00 PM EDT

Thursday, April 7
11:00 AM - 12:00 PM EDT

Thursday, May 5
11:00 AM - 12:00 PM EDT

No registration required.
Questions can be
submitted in advance.
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Retiring Data Packages
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Retiring New Hire (End of Day)

Data items reportable using New Hire (End of Day) are now all available via the
Hiring Data Warehouse.

Run the Cognos Reports List report (selecting New Hire (End of Day) in the prompt)
to obtain a list of reports for your office/organization.
236 NHEOD reports currently exist

* o Mew Hire I:El‘"id DfDﬂ.‘,’ﬁ ¥ & Hiring Data Warehouse

i i A Presentation Vi

¥ U Presentation View M reie ion View
P [ Announcements

* ¥ Mew Hires » [ Applicants

* = Mew Hire Detail » [0 Applications
b §ill New Hire : E gzﬁfj”:m Packages
rimcates
» il Mew Hire Appointing Authorities v & New Hirss

i Mew Hire Forms ¥ (= New Hire Contacts

» Bl Benefits Contacts
» Wil HR Contacts

b il Pavroll Contacts

i Mew Hire Forms Transmissions

v v
-
-

I Mew Hire Interconnection Transmissions

The retirement of New Hire (End of Day) has been extended to February 4, 2022

USA Staffing Account Managers have been provided with a list of reports using
New Hire (End of Day) and will be reaching out to help provide or coordinate
support for meeting this timeline.
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Retiring Staffing Analytics

Data items reportable using Staffing Analytics for user license reporting are now all
available via the User License data warehouse.

Run the Cognos Reports List report (selecting Staffing Analytics in the prompt) to
obtain a list of reports for your office/organization.
175 Staffing Analytics reports currently exist

v ¥ UserLicense
~ ¥ Presentation View

¥ [¥ Staffing Analytics ¥ [# User Details

¥ [ Presentation View » Il Account Address
. » i Account Details
» ¥ Hiring Process

v [ UserLicenses » il Office/Customer
¥ (= User License Detail » fli Organization
b ili Permission Profiles g E Permission Profile
= X » Il Service Account Details
P I Staffing Customer b i User Type
3

» il Staffing Offices
» il Staffing Organizations ¥ [ User Metrics
» fli Organization and Office

» i i
i User Accounts » il Paid Account Address

= . .
> i User License Metrics » i Paid Account Details
» il User License Trend Dates » il Paid Account Flags
» B2 Pai A :
» m User Types E Paid Service ACCDLfm Details
» il User Account Metrics

» il UserDates

The retirement of Staffing Analytics has been extended to February 4, 2022

USA Staffing Account Managers have been provided with a list of reports using
Staffing Analytics and will be reaching out to help provide or coordinate support
for meeting this timeline.
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Modifications to Reports and Data Models

Sprint 15 deployed to Production on January 19t
Sprint 16 will be deployed to Production on February 2"d
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HDW Reports

New/Modified Reports

Applicant Touch Points Report — deployed January 19t
The Applicant Touch Points Report was created. This report provides tabular data displaying the
applicant touchpoint notification status by vacancy and applicant.
« Team Content > USA Staffing Packages and Folders > Hiring Data Warehouse > Application

Declinations Dashboard - deployed January 19t

The Declinations Dashboard was modified. This report provides key metrics as well as tabular
data specific to declinations, including total number of declinations, the reason provided for
declinations, and timeliness measures. The report was updated to modify the underlying
queries for the organization and office prompts to improve prompt page loading time.

« Team Content > USA Staffing Packages and Folders > Hiring Data Warehouse > Application

Eligibility Overview Report — deployed January 19t

The Eligibility Overview Report was created. This report provides tabular data showing various

hiring metrics by eligibility for a fiscal year, as well as new hires by series.

« Team Content > USA Staffing Packages and Folders > Hiring Data Warehouse > Production
Metrics



USA Staffing

HDW Reports

New/Modified Reports

MCO Staffing Resource Chart — deployed January 19t

The MCO Staffing Resource Chart was modified. This report displays Time to Hire in the format
required by OPM for annual reporting. The report was updated to include an additional column
to show the average number of days between the announcement close date and tentative job
offer accepted date. This additional column was added in response to updated time to hire

reporting requirements. .
« Team Content > USA Staffing Packages and Folders > Hiring Data Warehouse > Time to Hire
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User License
Data Model Changes

Customer Details — will be deployed February 2n
A new query subject and query items were added in the User Details namespace to enable
reporting on additional details about customers.
» Customer Details query subject
* [User Details].[Customer Details].[Agency Code]
» [User Details].[Customer Details].[Agency Name]
» [User Details].[Customer Details].[Agency Reference Code]
» [User Details].[Customer Details].[Department Code]
» [User Details].[Customer Details].[Department Name]
* [User Details].[Customer Details].[eOPF Instance]
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User License
Data Model Changes

User Metrics — will be deployed February 2"
The criteria for user inclusion in the User Metrics namespace were updated to ensure accurate
accounting for paid users.

Original Criteria Updated Criteria

 User assigned to a Primary Office  User assigned to a Primary Office

« User has a paid permission profile » User has at least one paid
associated with their Primary Office permission profile

» User is not retired « User is not retired

« User is not an excepted user « User is not an excepted user



USA Staffing

APl Updates



USA Staffing

USA Staffing Data APIs

Onboarding Tasks APl Update — deployed February 2"
The Onboarding Tasks APl was updated to include additional columns for reporting on more
details about tasks.

e Task Instructions
e Task Result
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USA Staffing Data APIs

Sorting and Performance Enhancements - deployed January 19"
The following APIs were updated to ensure users see their most recently updated records first.
Additional updates to improve performance were also made.

 Time to Hire

* Organization

« Office

* Customer

* Announcement
* Assessment

* New Hire

Performance Enhancements - deployed February 2"
The following APIs were updated to improve performance when using the expand parameter.

* Request
* Customer
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Cognos Tip

Applicant Flow Data Reporting
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Applicant Flow Data Analytics

- Demographic information collected from job seekers and combined with
milestones in the hiring process

« Data is near real-time (nightly load) for vacancies that meet certain criteria

« Data is optimized for metrics and aggregate data and trend reporting
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How is Applicant Flow Data Collected?

Demographic information from the job seeker’s USAJOBS Profile is
included when they submit a job application

== An official website of the United States Government.

USAJOBS =l 2

B2 An official website of the United States Government

USAJOBS - I

& MyAccount Contact  Eligibility ~ Demographics  Account  Other
Include Personal

nalys )
agemen o
S Select eview
& Profile tesume ackage Info

% Resumes PI'OﬁlE

Q saved Searches Demographics

Your Privacy Is Protected
& Inbox 4 Your demographic information will not be sent to the hiring manager responsible for this position. It is used solely for statistical purposes
B Saved Jobs This information is used to determine if our recruitment efforts are reaching all segments of the population, consistent to assist the agency in the development of recruiting plans and to ensure the agency is reaching all segments of the population.

with Federal equal employment nity laws. Your voluntary responses are treated in a highly confidential manner.

(7] saved Documents Your responses are not released to the panel rating the applications, to the selecting official, to anyone else who can

affect your application, or to the public. No information taken from this form is ever placed in your Personnel file. Thisis I nclu d e Pe rsona l I nfo rmatio n

vital information not available from any other source. We can only get it directly from you. @

(@ Application Status

Completion of this form is voluntary. No individual personnel selections are made based on this information. There will | ivolunteer to provide my demographic information to hel
be naimpact on your application if you choose not to answer any of these questions. ine if the government’s equal ent opportunity
efforts are reaching all segments of the population.

USAJOBS Profile = Job Applications

Job seekers provide responses to Applicants opt to include the
demographic questions when demographic information from

they build a USAJOBS profile. The their USAJOBS profile to

USAJOBS profile can be updated at individual job applications.

any time by the applicant. Applicants can opt in or out for
each job application.



USA Staffing

How is Applicant Flow Data Collected?

Sex and Ethnicity/Race and National Origin

USAJOBS o

Help Search
& My Account Contact  Eligibility ~ Demographics  Account  Other
| & Profile
a Resumes Pl'Oﬁle
Q, Saved Searches Demographics
& Inbox Your Privacy Is Protected
B Soved Jobs This information is used to determine if ur recruitment efforts are reaching all segments of the population, consistent

with Federal equal employment opportunity laws. Your voluntary responses are treated in a highly confidential manner.

€F] Saved Documents Your responses are not released to the panel rating the applications, to the selecting official, to anyone else wha can

(2 Application Status affect your application, or to the public. Noinformation taken from this form is ever placed in your Personnel file. This is

vital informatian not available fram any other source. We can only get it directly from you. @

Completion of this form is veluntary, No individual personnel selections are made based on this information. There will

be no impact on your application if you choose not to answer any of these questions.

\:I | wish to decline to respond to the demographic questions.

1. Sex:

Male

2. Ethnicity:

) Hispanic or Latino - a person of Cuban, Mexican, Puerta
Rican, South or Central American, or other Spanish culture or

origin, regardless of race

/Mot Hispanic or Latino

3. Race (Check all that apply):

(] American Indian or Alaska Native - a person having origins in
any of the original peoples of Narth or South America (including
Central America), and who maintains tribal affiliation or
community attachment.

EI Asian - a person having origins in any of the original peoples
of the Far East, Southeast Asia, or the Indian subcontinent,
including, for example, Cambaodia, China, India, Japan, Korea,
Malaysia, Pakistan, the Philippine Islands, Thailand, or Vietnam.
[ Black or African American - a person having origins in any of
the black racial groups of Africa.

[] Native Hawaiian or Other Pacific Islander - a person having
origins in any of the original peoples of Hawaii, Guam, Samoa, or
other Pacific islands.

) White-a person having origins in any of the original peoples
of Europe, the Middle East, or North Africa.

Disability

4, Disability/Sericus Health Condition:

The next questions address disability and serious health conditions. Your responses will ensure that our outreach and
recruitment policies are reaching a wide range of individuals with physical or mental conditions. Consider your answers
without the use of medication and aids (except eyeglasses) or the help of another person.

A. Do you have any of the following?

Check all boxes that apply to you:
(] Deaf or serious difficulty hearing
[:J Blind or serious difficulty seeing even when wearing glasses
I:‘ Missing an arm, leg, hand, or foot
[:\ Paralysis: Partial or complete paralysis (any cause)
[j Significant Disfigurement: for example, severe
disfigurements caused by burns, wounds, accidents, or
congenital disorders
[ Significant Mobility Impairment: for sxample, uses a
wheelchair, scooter, walker or uses a leg brace to walk
[:‘ Significant Psychiatric Disorder: for example, bipolar
disorder, schizophrenia, PTSD, or major depression
[j Intellectual Disability (formerly described as mental
retardation)
[J Developmental Disability: for example, cerebral palsy or
autism spectrum disorder
(] Traumatic Brain Injury
) Dwarfism
[} Epilepsy or other seizure disorder
(") Other disability or serious health condition: for example,
diabetes, cancer, cardiovascular disease, anxiety disorder, or HIV
infection; aleaming disability, a speech impairment, or a hearing
impairment

Ifyou did not select one of the options above, please indicate
whether:

[) None of the conditions listed above apply to me.

D I do not wish to answer questions regarding disability/health
conditions.

If you have indicated that you have one of the above conditions, you may be eligible to apply under Schedule A Hiring

Autharity. For more information, please see http://www.opm.gov/policy-data-oversight/disability-

employment/hiring/#url=Schedule-A-Hiring-Authority.

Paperwork Reduction and Privacy Act Statement

Source Form:
https://www.eeoc.gov/federal/upload/Applicant

Tracking Form 2-19-2014-2.pdf
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How is Applicant Flow Data Collected?

Veterans' Preference

3. Are you a Veteran of the U.5. Armed Forces or are you eligible Definitions
for "derived” preference?
Yes () No

® Do you claim Veterans' Preference? ° _Job Seekers claim veterans'
Mo, | do not claim Veterans' Preference preference in their USAJOBS
) 0-point Sole Survivorship Preference (SSP) proﬁle and u p|0ad su pporting
5-point preference based on active duty in the U.5. Armed .
Forces (TP) documentation
10-point preference based on a compensable service
connected disability of at least 10% but less than 30% (CP) ° H R profeSSIOna |S adjudicate
10-point preference based on a compensable service ’
connected disability of 30% or more (CPS) veterans preference by
10-point preference for non-compensable disability or ve rlfyl ng dOCU mentatlon
i g during the hiring process

() 10-point preference based on widow/widower or mother of a

deceased veteran, or spouse or mother of a disabled veteran (XP)

Veterans' Preference Guidance: https://www.opm.gov/policy-data-oversight/veterans-employment-
initiative/vet-quide/#2Types
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Guidelines for Use of Applicant Flow Data

Applicant Flow Data may be used for:

A. Aggregate human capital reporting

B. Determining rates of demographic representation in recruitment efforts

C. Determining rates of demographic representation in hiring or merit
promotion selections

D. Determining rates of qualifications among demographic groups

E. Evaluating the effectiveness of recruitment in reaching targeted
demographic groups

Applicant Flow Data may not be used for:

Influencing the decision to close or extend job announcements
Influencing the decision to cancel recruitment actions

Influencing the decision to use or not use a referral list of applicants
Influencing selection decisions

|dentifying the race, ethnicity, or gender of specific named employees

moN®

Rules of Behavior:
https://help.usastaffing.gov/ResourceCenter/images/c/cf/Applicant Flow Data Access SOP 10-

25-19.pdf
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Guidelines for Use of Applicant Flow Data

USA Staffing has implemented safeguards to prevent the misuse of
Applicant Flow Data.

Your voluntary responses are treated in a highly confidential manner. Your responses are not released to
the panel rating the applications, to the selecting official, or to anyone else who can affect your
application. This is vital information not available from any other source. No individual personnel

selections are made based on this infarmation. No information taken from this form is ever placed in your

Personnel file.

Access Availability No Pll
Customer agencies are Data are only released Personally-identifiable
responsible for after hiring actions are information is not
determining which complete (certificates included in the data
users can access AFD audited) provided
AFD Access SOP:

https://help.usastaffing.gov/ResourceCenter/images/c/cf/Applicant Flow Data Access S
OP_10-25-19.pdf
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Guidelines for Use of Applicant Flow Data

AFD is made available to users only if the vacancy is inactive, defined by these two
conditions:

< The announcement is not currently open
4 All certificates for a vacancy are audited or cancelled

If either of these conditions is not met, AFD will not be visible to users.

Additionally, if a previously inactive vacancy becomes active (e.g. the announcement is
re-opened, an additional cert is issued, or a cert is un-audited), AFD for that vacancy
will no longer be visible

o

0 l I
P et { ]
L H ]

* Announcement Opens + Certificates Issued to Hiring Manager * Inactive vacancies are
+ People apply for the job « Hiring Manager makes Selections added to ‘the AFD
* Announcement Closes ./ * HR reviews and audits all certs ./ dataset nightly
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Standard Applicant Flow Data Reports
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MD-715 “A” Tables

BB Teamcontent > USA Staffing Packages and Folders > Applicant Flow Data » Applicant Flow Data Analytics

This report includes summarized applicant responses to ethnicity/race and sex demographic questions in the
USAJOBS job seeker profile to respond to the MD-715 requirements for the "A" Tables (Mission Critical Occupations
Distribution by Race, Ethnicity, and Sex).

- ® N n ® N
USA StOfflng E[ v £ New report USA StOfflﬁg E} v C New report v
o Total Applications Race, Ethnicity, and Sex 0 Total Applications Race, Ethnicity, and Sex
@@ MD-715 Announcement Type: Internal Competitive Promotion (O}l MD-715 Announcement Type: Internal Competitive Promotion
(N
- Occupational Series: 0201 - Human Resources Management o Occupational Series: 0201 - Human Resources Management
5 SexResponse  Total Applications Qualified Applications Referred Applications = Selected Applications 2 ST S ELYREED REDETE Total Applications | Qualified Applications | Referred Applications | &
m Male 659 172 108 5 [22] Hispanic or Latino Males 89 15 9
Female 1,381 461 285 7 Hispanic or Latino Females 165 50 24
(W wnite Males 208 56 39
0 Omitted

White Females 272 87 59
Tt st 2663
Rlack or African American Males 294 85 50

Required Prompts: Optlonal Prompts:

+ Organization Name(s) Customer Name(s)
+ Office Name(s) » Occupational Series
* Fiscal Year(s) » Grade(s)

* Announcement Appointment Type(s)
» Supervisory Position

* Announcement Type(s)

* Vacancy Number(s)

+ Application Submitted Date Range
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MD-715 “B” Tables

BB Teamcontent > USA Staffing Packages and Folders > Applicant Flow Data » Applicant Flow Data Analytics

This report includes summarized applicant responses to disability questions in the USAJOBS job seeker profile to
respond to the MD-715 requirements for the "B" Tables (Mission Critical Occupations Distribution by Disability).

USA Stoffihg@ B - - New report v USA Stoffquri M= - C New report v

o Total Applications Targeted Disabilities G Total Applications Targeted Disabilities
MD-715 Announcement Type: Internal Competitive Promotion ", .
Os P P (@@ MD-715 Announcement Type: Internal Competitive Promotion
-
Occupational Series: 0343 - Management And Program Analysis . o i
n h Occupational Series: 0343 - Management And Program Analysis
D Total Disability Total Applications Qualified Applications Referred Applications Selected Applications
m No Disability (05) 1202 584 364 9 b Targeted Disability Total Applications | Qualified Applications Referred Applications = Se
Not Identified (01) 1.260 648 450 15 22 | Developmental Disability (2) 4 2 0
° Disability (02-03, 06-99) Traumatic Brain Injury (3) 11 6 4
s L o oo oo s ° :

Required Prompts: Optlonal Prompts:

+ Organization Name(s) Customer Name(s)
+ Office Name(s) » Occupational Series
* Fiscal Year(s) » Grade(s)

* Announcement Appointment Type(s)
» Supervisory Position

* Announcement Type(s)

* Vacancy Number(s)

+ Application Submitted Date Range
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Applicant Flow Data Detail Report

BB Teamcontent > USA Staffing Packages and Folders > Applicant Flow Data » Applicant Flow Data Analytics

This report includes detailed data related to applicant responses to ethnicity/race and sex demographic questions in
the USAJOBS job seeker profile. Information gathered from this report can be aggregated to respond to MD-715 2.0
requirements or to complete other AFD analyses.

USA StOFflr‘lgi = v C New report v
0 bnt | Application Application Application Applied | Qualified Referred Selected Not Not Application = Application Sex Ethnicity
Last Record Record Status | Indicator | Indicator Indicator | Indicator Referred Referred- Claimed @ Adjudicated Response and
| Submitted Status Code Description - Eligible Veterans Veterans Race
O Date Code Ineligible = Not on Preference | Preference Category
- Indicator = Certificate = Description | Description
Indicator
B 12/27/2017 IN Ineligible for 1 0 0 0 1 0 NP - No Male Omitted
3 Certificate Preference.
m | 01/052018 IN Ineligible for 1 0 0 0 1 0 NP - No Female Omitted
Certificate Preference.
L3
Required Prompts: Optlonal Prompts:
« Organization Name(s) Customer Name(s)
+ Office Name(s) » Occupational Series
* Fiscal Year(s) » Grade(s)

* Announcement Appointment Type(s)
» Supervisory Position

* Announcement Type(s)

* Vacancy Number(s)

* Announcement Number(s)

» Application Submitted Date Range
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Applicant Flow Data Analytics Data Package
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pplicant Flow Data Analytics Data Package

The only source for Applicant Flow Data derived from the Upgrade version of
USA Staffing.

Query Subjects:

* Announcements
» Open and close date, status, who may apply, total openings, and announcement
number
* Announcement Appointment Types
« Appointment type
» Applications
« Applicant unique identifier, veterans preference, eligibility, record status code, last
submitted date, status, and indicators for qualified, referred, and selected.
 Disability
» Disability response, indicator, and targeted disability indicator
 Ethnicity and Race
 Indicators for each ethnicity and race as well as the ethnicity and race category of
an application

Data Dictionary for the Applicant Flow Data Analytics model:
https://help.usastaffing.qgov/USASUpgResCtr/imaqges/f/fb/AFD Analytics - Data Dictionary.pdf
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Applicant Flow Data Analytics Data Package

The only source for Applicant Flow Data derived from the Upgrade version of
USA Staffing.

Query Subjects:

* Metrics
» Counts of the total number of applications, qualified applications, referred
applications, and selected applications
*  Sex
« Sex response
» Trend Dates
» Dates to identify timeframes for announcement close and application last
submitted, including month, quarter, and year using both calendar and fiscal dates
» Vacancy Customers
» Customer information including customer name and the tenant, agency, and
department of the customer.

Data Dictionary for the Applicant Flow Data Analytics model:
https://help.usastaffing.qgov/USASUpgResCtr/imaqges/f/fb/AFD Analytics - Data Dictionary.pdf
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Applicant Flow Data Analytics Data Package

The only source for Applicant Flow Data derived from the Upgrade version of
USA Staffing.

Query Subjects:

* Vacancy Detail
» Vacancy number, pay plan, series, grade, job title, announcement type,
supervisory position indicator, and vacancy status
» Vacancy Offices
» Office name and code
* Vacancy Organizations
« Organization tenant, name, and code
» Vacancy Rating Combinations
» Series, grade, specialty, and title

Data Dictionary for the Applicant Flow Data Analytics model:
https://help.usastaffing.qgov/USASUpgResCtr/imaqges/f/fb/AFD Analytics - Data Dictionary.pdf
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Open Demo and Q&A
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Resources and Contacts

IBM Cognos Analytics User Guide

The official IBM user guide for Reporting via Cognos Analytics:
https://www.ibm.com/support/knowledgecenter/SSEP7) 11.0.0/com.ibm.swg.ba.cog
nos.ug cr rptstd.doc/ug cr rptstd.pdf?view=kc

USA Staffing Resource Center

Under the Reports and Analytics section, you'll find presentations from previous

workgroup sessions and other resources:
https://help.usastaffing.gov/ResourceCenter/index.php?title=USA Staffing Resource
Center

Need Help?

If you are experiencing issues accessing Cognos or need help to create or
troubleshoot a report, submit a HelpDesk ticket through USA Staffing. If you are
unable to submit a HelpDesk ticket, please contact us at
USAStaffingData@opm.gov




